
  ProgressBook StudentInformation Introduction to Ad-Hoc Reporting 
 

 

 

 

 

 

 

 

 

 

ProgressBook StudentInformation 
Introduction to Ad-Hoc Reporting 

 

 

 

 

 

 

 

 

 

 

 





  ProgressBook StudentInformation Introduction to Ad-Hoc Reporting 
 

 

Table of Contents 
1 Security ........................................................................................................................................................................... 1 

2 Analytics Hub .................................................................................................................................................................. 6 

3 Report Designer Overview .............................................................................................................................................. 8 

3.1 Report Designer Layout .......................................................................................................................................... 8 

3.2 Report Types ......................................................................................................................................................... 10 

3.3 Module Folder Structure ....................................................................................................................................... 10 

3.4 Report Folder Types .............................................................................................................................................. 10 

3.5 Report Execution ................................................................................................................................................... 11 

3.6 Export Options ...................................................................................................................................................... 12 

4 Report Filtering ............................................................................................................................................................. 13 

4.1 Simple Without Operator...................................................................................................................................... 13 

4.2 Simple With Operator ........................................................................................................................................... 13 

4.3 Standard/Default Filtering .................................................................................................................................... 14 

5 Duplicating a Report ..................................................................................................................................................... 16 

6 Report Scheduler ...................................................................................................................................................... 1817 

6.1 Scheduling Reports ........................................................................................................................................... 1817 

6.2 Scheduled Report Management ....................................................................................................................... 2120 

6.3 Email Report ...................................................................................................................................................... 2120 

7 Sharing Reports ......................................................................................................................................................... 2521 

7.1 Downloading a Report ...................................................................................................................................... 2521 

7.2 Uploading a Report ........................................................................................................................................... 2521 

8 ExpressView .............................................................................................................................................................. 2723 

8.1 expressview Report ........................................................................................................................................... 2723 

9 Express Report Wizard .............................................................................................................................................. 3026 

9.1 Creating an Express Report ............................................................................................................................... 3026 

10 Workshop Demos .................................................................................................................................................. 3531 

11 Syncer & System Reports ...................................................................................................................................... 3632 

 

 



Security 

1  ProgressBook StudentInformation Introduction to Ad-Hoc Reporting 
 

1 SECURITY 

PBST provides a base set of security roles that can be used by ITCs and districts to grant access to the various folders 

available.  All roles created by the PBST Team begin with AH-.  

 

  

There are two main types of roles: Viewer and Admin Viewer. A base viewer role grants access to the main Ad Hoc folder 

type but not to its admin folder. 

Note: “Full” roles should not be used in conjunction with the individual module folder names.  

Example 1: John Smith needs to have access to run different report types at different buildings and he should be able to 

use any report available no matter the folder level, including admin. This means his role security should have AH-Full 

Viewer. 
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Example 2: John Smith needs to be able to access different module folders within different buildings and should not be 

able to run reports outside of those areas. At the high school, he needs EMIS and admin folders. Also at the high school, 

he should have access the Medical folder but no access to the Admin folder. At the middle school, he needs to run 

Attendance reports and Attendance Admin reports. At the elementary school, he should have access to run Mark 

reports but no access to the Marks Admin reports.  

 

Besides the Admin Viewer and Viewer roles, there are two manager roles.  

• AH-Full Admin Report Manager – Meant for district support personnel to create and manage reports for 

districts. This role can delete and change existing district reports.  

• AH-ITC Report Manager – Meant for ITC support personnel to create and manage reports for districts. This role 

also has access to the ITC folder, which contains reports that can be run for the entire ITC at once.  

Note: There are two Writer roles (AH-Full Report Writer & AH-Full Report Admin Writer) that were 

originally created when Ad Hoc Reporting was implemented. They are no longer valid and should 

not be used.  

If additional roles beyond the PBST base roles are needed, they can be created. There are two security sections that 

security administrators need to be aware of when creating new roles:  
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1. Edit Sitemap Access -> Local – This section grants users the ability to create and store reports into My 

Reports and possibly other places based on their Ad Hoc Reports security section under Edit Resource 

Permissions. At minimum, a user should have a blank or green dot on the Analytics Hub in order to run Ad 

Hoc Reports. If users should not have access to the Report Designer, you need to have an X on the Ad Hoc 

Reports line as shown below.  

 

 

2. Edit Resource Permissions -> Ad Hoc Reports – This section is found under the Edit Resources button of the 

security roles. The resources option controls folder access and the available reports within those folders.  As 

you can see in the screenshot below, the security nodes available mirror the folder structure.  Permissions 

granted to these nodes will allow a user to gain access to reports within these folders. 

 

Resource Security Nodes Ad Hoc Folder Structure 
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1.1 SECURITY ROLE EXAMPLES 
If additional roles need to be created beyond what PBST has provided, this section provides some examples of site map 

permissions and how the folder structure will be viewed by the user through the Ad Hoc Reporting module. 

1.1.1 Report Manager 

Security Role Access Folder Access 
Full access to all data objects, system-level report folders and 
scheduling reports 

Full access to all report folders in the report 
designer 

 

 

1.1.2 All Reports Read-Only Example 

Security Role Access Folder Access 
Display access to all reports The user will not have designer access but will see 

all areas within the Analytics Hub area 
 

 

1.1.3 Discipline Admin Read-Only Example 

Security Role Access Folder Access 
Display only to Discipline and Admin folders User can only see Discipline folder and sub folder 

on the Analytics Hub screen. They will not have 
access to the Report Designer area. 
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1.1.4 Discipline non-Admin Read-only Example 

Security Role Access Folder Access 
Display only to Discipline folder and block Admin folder User can only see Discipline folder, Admin is hidden 

on the Analytics Hub Screen. They will not have 
access to the Report Designer area. 
 

 
 

SECURITY TIPS 

• Users can be restricted as to where they can run reports by building level; however, it does not mean that they 

can only run reports for that building. Users who can run Ad Hoc Reports do so for the entire district even 

though they may not be able to access the entire district via the rest of the web application.  

• All users have their own My Reports folder.  My Reports a writable folder where users can copy existing 

reports to or create their own reports. 

• Users with write access to at least one of the “system-level” report folders will get access to a district level 

Pending Reports folder.  The Pending Reports folder is a special district-level folder used for working on new 

reports. 

• Once a report is ready for release, a district report admin can move the report to the appropriate system-level 

folder (e.g.  Discipline, Fees, Marks, etc.), thus making it available for other users to run. 
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2 ANALYTICS HUB 

Ad Hoc reporting is available within the ProgressBook Suite as an effective standardized reporting system for 

StudentInformation and related applications. The Analytics Hub provides a simple way for users to run reports. It can be 

accessed two ways within StudentInformation. Users can follow the breadcrumb trail Local -> Analytics Hub – OR – click 

the Page Widget found on the top right side of the StudentInformation tool bar.  

  

The page widget also shows users the most recent reports that they have run. On the Analytics Hub screen, a list of 

reports display depending on the security roles assigned to the user.  

 

Once you select a report, the screen will refresh and either show filter options for the user to choose the data they 

would like to review within the report or the report will execute.   
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After a report displays data, you can review the report by flipping through the data pages or using the find box to locate 

specific data within the report. Users will also be able to download the report with the available export icon. 

  

 

To get back to the main Analytics Hub to see the cards or list of reports, click the icons found at the top right of the 

Analytics Hub screen. The left icon displays the reports and their descriptions in the card format. The right icon provides 

a simplified list of reports and descriptions.  

 

Note: Analytics Hub Only users can only run reports.  
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3 REPORT DESIGNER OVERVIEW 

To access the Ad Hoc Reports Designer screen, users must go to the breadcrumb trail Local -> Ad Hoc Reports. If a user 

does not see the Ad Hoc Reports option, it means the user does not have the right security configuration.  

 

3.1 REPORT DESIGNER LAYOUT 

 

1. Report Creation Wizards – Click this icon to bring down an icon drop-down list and allow users to start one 

of 4 report wizard options: ExpressView, Express Report, Standard Report, and Crosstab Report. 
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a. ExpressView ( ) – Explore data and get quick answers using drag & drop in a highly interactive 

designer. 

b. Express Reports ( ) – Quickly create tabular reports with essential operations like sorting, 

filtering, and calculations. Easily format and summarize data. 

c. Standard Reports ( ) – A familiar, Excel-like design grid with access to advanced functionality like 

Charts, Maps, the Formula Editor, and Conditional Formatting. 

d. Crosstab Reports ( ) – An intuitive Crosstab Wizard simplifies the process of creating complex 

tables with summary results grouped in both rows and columns. 

2. Run Reports ( ) – Select a report and then click on an extract type icon lets the user execute a report. See 

Section 3.5 for further details regarding this feature. 

3. Report Management Toolbar – The user will need to go to the module folder window (see step 5) and locate 

the report to which they would like to perform one of the following tasks: 

  
a. Edit Report – Select a report and then select this icon to edit a report that is not locked. 

b. Duplicate Report – Select a report and then click this icon to create a copy of a report for further 

customization. See Section 5 for more details regarding this feature.  

c. Delete Report – Select a report and then click this icon to delete a non-system report. 

d. Schedule Report – Select a report and then click this icon to schedule a report; you can immediately 

send the report to one user or the manage reports scheduler queue. 

e. Export Report – Select an option to run and automatically export a selected report into Excel, PDF, 

RTF, or CSV. 

4. Search Reports ( ) – Use the search bar to find any available report within the 

system to either run or edit it. Click the sprocket settings at the end of the search toolbar to search by name 

and/or description depending on how fast/slow you want the search to produce results.  

5. Module Folder list – This section contains a folder list related to the available modules as well as reports 

available to the user based on their security access. See Section 3.3 for further details.  

a. Report Description – Selecting a report will display a report description in this section. 

6. Report Tabs – As you run or edit reports, a tab will appear for each instance.  
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3.2 REPORT TYPES 
1. System Report – A report created by the PBST group and dispersed to the ITC/Districts via Syncer. 

a. System Reports can only be created and distributed by the PBST. It is a read only report and will have a 

lock icon. 

b. System Reports are synced to corresponding folders [Discipline, Fees, Attendance…] from the State Level 

to the ITC. 

2. District Report – A report created by personnel with the ITC/District. District Reports are created when:  

a. A System Report is copied – that copy is considered a District Report. 

b. District reports are not read only, which means anyone who can modify reports can do so at any time 

within the district. 

c. A user can create a District Report using the SIS data categories provided. 

3. User Report – A report that exists in a user’s My Reports folder. 

3.3 MODULE FOLDER STRUCTURE  
When viewing the module folder structure in the Ad Hoc Report Designer, any or all folders may display to a user 

depending on the security provided. Security Roles have been designed to mimic this structure.  Within each main 

module topic folder, there is an Admin folder than may contain reports needing more restrictive access.  

 

3.4 REPORT FOLDER TYPES 

 

1. My Reports folder – A holding area for User Reports. 

a. Every user with access to the Report Designer has a My Reports folder. 

b. Users may duplicate any report they have access to and store it in their My Reports. 

c. Users may modify/delete any report in their My Reports folder. 

d. Only the logged in user has access to this folder. ITCs cannot assist users with reports within this folder 

unless the report is moved to the Pending Reports folder or downloaded and sent to ITC support. DBAs 

can grab the stored xml code from the database but it is not a preferred method of 

viewing/troubleshooting Ad Hoc Reports.  
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2. Pending Reports – A holding area for users who can create reports and distribute them to other module folders. 

Typically, users who have access to this folder will be district power users or ITC Support. 

a. Users that have “Edit” capabilities will have access to the Pending Reports folder. 

b. Users with access may also delete District Reports from this folder. 

3. Module Report Folder   

a. Contains System Reports and district created reports to all users with access. 

b. System (Locked) Reports in the application folder cannot be deleted or moved. 

c. System Reports in the application folder can only be copied and may be stored in any folder the user has 

access. 

3.5 REPORT EXECUTION 
There are many ways you can execute reports within the Ad Hoc Report Designer screen. 

1. Expand the Report Folder type > Select the Report > Click on the Run button or Export button and selecting an 

export option.   

  
 

2. Expand the Report Folder type > Right click the Report name you want to run, then select the Run button or 

Export button and select an export option. 
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3. While editing a report, you can execute it from the designer toolbar using either the Run button or Export 

button. 

 

3.6 EXPORT OPTIONS 
After a report has been executed, you can either review the report within the StudentInformation application or export 

the report data into one of several available format types. These format export types currently include: 

1. Excel ( ) – Will export your report and open it using Microsoft Excel. You will also have the option to 

save it to your hard drive as a xlsx file. 

2. PDF ( ) – Will export your report and open it using Adobe Acrobat Reader. You will also have the 

option to save it to your hard drive as a pdf file.  

3. RTF ( ) – Will export your report and utilize any program that is compatible with RTF files. You will also 

have the option to save it to your hard drive as a rtf file. 

4. CSV ( ) – Will export your report and utilize any program that is compatible with csv files. You will also 

have the option to save it to your hard drive as a csv file. 
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4 REPORT FILTERING 

If there are no filters to be completed, an Ad Hoc Report will execute automatically and display the data results. There 

will be some created reports that will greatly benefit from having a few pre-determined filtering fields. Some examples 

are school year, building, grade level, or a combination of several fields.   

When an Ad Hoc System, District, or User report requires parameters, one of the following parameter type windows will 

display to the user.   

4.1 SIMPLE WITHOUT OPERATOR 
This filtering type is the easiest to use. The user will simply select values from available filter dropdowns. They will click 

OK and the report will generate. 

 

4.2 SIMPLE WITH OPERATOR 
This filtering type allows users to select a condition type as well as values from available filter dropdowns. Once a 

condition and value(s) have been selected, the user will click OK and the report will generate. The condition statements 

that are available are: Equal To, Not Equal To, Less Than, Less Than or Equal To, Greater Than, Greater Than or Equal 

To, Starts With, Not Starts With, Ends With, Does Not End With, Contains, Does Not Contain, Is Between, Is Not 

Between, Is One Of, and Is Not One Of.  

• The Is One of and Is Not One Of conditional statements will allow users to choose multiple values.  

• Is Between is useful if users want to select a Date Range between 2 dates. 

• Not Equal To or Is Not One Of is useful if you do not want to select any values at all for certain filters. 

o Example: If users want all GradeLevels or all Status options returned for students, they will select the 

Not Equal to or Is Not One Of condition statement and leave the field blank. This type of filtering works 

because all students must have a grade level and status assigned during registration. Therefore, all 
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students will be returned because no students within the database will have a blank value for either 

field.  

 

4.3 STANDARD/DEFAULT FILTERING 
This filtering option is the hardest to understand and can be a little daunting. However, standard filtering can make a 

simple standard report very powerful and versatile. Users can set up default filtering values during the report 

design/editing process along with default values. When running a report, the filtering screen works the same way as 

when you create/edit a report. 

 

1. Category Dropdown – This dropdown provides a list of all available categories within the report. You can choose 

any field from any category for filtering. 
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2. Category Data Fields – After selecting a category from the drop-down list, all data fields within the category will 

be listed. If users desire, they can remove data fields from section 3 and add different data fields to section 3. 

They can also add additional data fields to the already existing ones if the user requires a smaller set of data for 

their report.  

3. Data Field Filter List – This section lists all filters that are used for the report. Clicking X removes a filter. Use the 

up and down arrows to move filters into a different order.  

4. Switch to Group Min/Max filters – Switching to this option allows you to add additional filters based on 

maximum or minimum values of data fields. An example of its benefit is to find the maximum or minimum test 

score for each student for an assessment test.  

5. Conditional Filter – This functions the same as the Simple with Operator conditional filter. See section 4.2 for 

further details regarding the conditional statements.  

6. Filter Relationship Dropdown – Specify the relationship between filters and group them together if certain fields 

are dependent upon one another. Select AND to require that the selected filter and the one below are both 

true. Select OR to require that either the selected filter or the one below it are true. 

7. Value Dropdown – This dropdown is populated by data in the database like the other two filtering options 

described in sections 4.1 and 4.2. If the drop-down list is blank, this means that there are no values within the 

database to further filter on. A blank drop-down list could mean that all the filtering above that drop-down list 

has eliminated any available data options that exist – OR – that the data simply doesn’t exist yet in the database.  

8. Group with Next Filter – This is used in conjunction with item 6 with the And/Or option. Enabling this check box 

places parentheses around the selected filter and the one that follows to group the two or more filters together. 

9. Prompt for Value – Allow the selected filter to be modified when the report is run.  

10. Summary box – This summarizes all of the above filtering options into one space. 

Once all parameters have been completed, the user will click OK and the report will execute.  

FILTERING TIP 

In any of the filtering types, users will have the ability to type into available filtering fields. However, users should be 

cautious when typing values in lieu of choosing from the drop-down list. Mistyped values or formatting errors could 

produce reports that have little or no results. 
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5 DUPLICATING A REPORT 

Even as a basic Ad Hoc Reporting user, Ad Hoc Reports can be duplicated and stored in the user’s My Reports folder. 

After a duplicate has been created, the user will be able to save, edit, and run the report until they delete it. To duplicate 

a report, a user will need to navigate to the Ad Hoc Report Designer (Local > Ad Hoc Reporting). After the designer has 

been loaded, the user can complete the following steps. In this example, we will be copying the Student Address 

Standardization Error Report. 

1. Expand the folder where the report is stored from the folder structure on the left. Click on the report to select it. 

 

 
2. Either select the double page icon at the top – OR – right click the report to get the pop-up menu and choose 

Duplicate. 

 

 
 

3. A new window will appear for the user to rename (if desired) and place the duplicated report into a different 

folder (e.g., My Reports or Pending Reports).  
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4. Click OK to finish the report duplication process. The user is then redirected back to the main Report Designer 

screen and will be able to expand the folder structure to see the new report. Now, the user can execute or edit it 

as desired. 

Note: When duplicating and modifying a report, the child copy is not linked to the parent original. If 

a change occurs to the parent original report, that change will not sync down to the child copy. 
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6 REPORT SCHEDULER 

6.1 SCHEDULING REPORTS 
Any existing report within the Ad Hoc Reporting system can be scheduled to run and either emailed or FTP’d to users. To 

schedule reports, you must complete all scheduling from the Ad Hoc Report Designer screen (StudentInformation > 

Local > Ad Hoc Reports). 

1. You can schedule a report via the Ad Hoc toolbar or by right selecting a report and choosing Schedule Report – 

or – select a report and click the page with the clock from the toolbar above.  

 
2. Once you click Schedule Report, the Report Scheduler wizard displays. 

 

A. Schedule Name – Enter the name of the job. 

a. For example, you want to run the Contact Address Standardization Error report every night after the 

service job runs, so that you know which addresses need to be corrected the next day. An example 

schedule name would be “Contact Address Standardization Errors @ 9 PM Nightly.” 

B. Export Type – Select Excel, PDF, CSV, or RTF from the drop-down list. 
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C. Password (optional) – The password fields can be set so the file can only be opened with a password. You 

must remember to tell your recipients the password so that they can open the file. If you forget the 

password, you will have to edit your job, change the password, and rerun the scheduled job. 

D. Execute Immediately – You can select this check box to execute the report immediately but all other 

scheduling options will become unavailable. 

E. Schedule Time – Select or enter the time you would like the report to run. When you click , a drop-down 

list displays and you can select an hour or half hour time period. If you want to run the report at a different 

time, you can type in a time or select an option and then edit it.   

F. Recurrence Pattern – The default option for the recurrence pattern is Once. Other options for recurring 

patterns include: Daily, Weekly, Monthly, and Yearly. Each recurring pattern option has different settings to 

ensure that the report can be sent as it is needed.  

G. Range of Recurrence – Once a recurrence pattern is set, the range of recurrence will become available so 

that you can choose the time period in which the report will run.  

 

3. After you select all scheduling options and click Next, you are taken to the Filters tab. If any filters are required 

for the report to run, you will set up the report so that it provides the detail that is needed. See section 4.3 on 

how to utilize the Standard Filtering screen.  

 

Remember: If no filters are chosen, incorrect or no data will be provided in the report. 

4. Once all filters are selected, click Next and the wizard will move you to the final Recipients tab. Here you will be 

able to setup to whom the report is sent on a regular schedule.  
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While you are provided a subject line by default, it is recommended to change the subject line to something meaningful 

to you and/or the users receiving the scheduled report. Once everything is completed, you can click Finish. A display 

windows states that the report is successfully scheduled.  
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6.2 SCHEDULED REPORT MANAGEMENT 
To manage your scheduled reports, you must use the Ad Hoc Reporting toolbar available within the Ad Hoc Report 

Designer screen (StudentInformation > Local > Ad Hoc Reports). 

  

From the Scheduled Reports screen, you will be able to see all of the information pertaining to your scheduled reports, 

edit the scheduled report job parameters, and delete the scheduled report job.  

 

a. Schedule Name 

b. Type of Scheduled Job – Type of recurrence pattern scheduled 

c. Report Name – Name of the report that the job is running 

d. Last Run Date – Shows the date the report was last run successfully 

e. Next Run Date – Shows the next date the report is scheduled to run 

f. Status – Current job status 

g. Run Count – Number of times the report has been run or attempted 

h. Icon to edit the scheduled report job parameters 

i. Icon to delete the scheduled report job 

 

6.3 EMAIL REPORT 
The second option from the Ad Hoc Report toolbar, Email Report, lets you select any report available to you and email it 

to one person.  

  
 

Note: If multiple recipients need to receive a copy, you must to schedule the report. 
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6.4  SCHEDULING FTP JOB 

6.4.1 Report Setup 

Reports within the system can be FTP’d but before that can happen, the report must be marked as Is_Vendor_extract. 

1. To ensure that this setting is complete, right click and edit a report. Click on the settings sprocket -> Options -> 

Custom. 

 

2. A new window will open for designers to enable the Is_Vendor_Extract check box. Click OK, then Save. The 

report will now show up on the Vendor Extract Report Config district administration screen. 

Note: Any reports found within the Vendor Extract folder and is distributed by PBST will have the 

Is_Vendor_Extract check box selected. 

6.4.2 FTP Server Setup 

Before you can transfer files created by Ad Hoc Reports through FTP or SFTP, you must set up the credentials for 

accessing the server on the Vendor Extract Report Config screen. The server should already be set up for (S)FTP and you 

should have the credentials on hand.  

1. With a district in context on the Vendor Extract Report Config screen, browse to StudentInformation – 

Management – District Administration – Vendor Extract Report Config and click Add Configuration.  

2. The Add Configuration window displays. 
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3. Enter the appropriate credentials in the fields.  

• Ad Hoc Report – Select an Ad Hoc Report that has the Is_Vendor_Extract check box selected.  

Note: Only Ad Hoc Reports with the Is_Vendor_Extract check box selected display in this list. If there are no 

reports with Is_Vendor_Extract selected, nothing displays.  

• Host – Enter the name of the host.  

• Port – Enter the port number.  

• Protocol – Select SFTP or FTP.  

• Encryption (only displays if you select FTP) – Select the type of encryption to use.  

• Username – Enter the username for the FTP server.  

• Password – Enter the password for the FTP server.  

• Remote Directory – Enter the remote directory to which the transfer file is sent.  

• Remote Filename – Enter the remote file name that displays after the transfer complete.  

4. Click Test Connection to verify that the credentials are accurate. If you receive an error message, ensure the 

credentials you have are correct and entered correctly.  

5. Click Save Configuration.  

6. A confirmation message displays and the new configuration is added to the grid.  
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7. You can now run the corresponding Ad Hoc Reports, which automatically transfer via (S)FTP. 

6.4.3 Schedule the FTP Job 

Once the report has been enabled to be a vendor extract and the system knows where to send the files, a scheduled 

job must be set up to tell the system how often to run the report and what filters should be used. To do this, you must 

go back to the designer screen and run the schedule job wizard. Section 6.1 explains how to set up the job. The only 

difference between emailing and FTP’ing is the setting on the Recipients tab – de-select the Email Results check box in 

the top right corner. De-selecting this check box forces the job to run as an FTP job and utilizes the settings from the 

Vendor Extract Report Config screen.  
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7 SHARING REPORTS 

Only users who have access to the Report Designer may share reports. Report Design users can share reports by 

downloading a WR file from the Report Designer screen. Only files that are unlocked can be downloaded. Locked reports 

must first be duplicated before downloading. After the file has been downloaded to their local machines, users can 

share the WR file with another district, their ITC Support team, or with the PBST group via email or a file sharing 

program. Any design user can also upload a WR file to any module folders that do not have a lock. 

7.1 DOWNLOADING A REPORT 
1. On the Ad Hoc Reports screen, locate the report that you want to download and share (without a lock).  

 

Note: You cannot share locked reports. Locked reports are System Reports that are synced down 

from PBST. 

2. Once your browser gives you the Save option, save the file to your local machine. Typically, most browsers 

default the save location to your PC’s Downloads folder, but you can choose to save WR files anywhere, 

including your PC desktop.  

7.2 UPLOADING A REPORT 
1. To upload a report to your local ad-hoc reporting area, right click on a folder that does not have a lock and click 

Upload. 
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2. Your browser then asks you where the WR file you want to upload is located. Navigate to that location, select 

the WR file and click Open.  

 
 

3. Ad hoc imports the file and refreshes the Report Designer screen, which auto-collapses the folders. Expand the 

folder in which you chose to upload the WR file and verify that the report WR file imported.  
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8 EXPRESSVIEW 

8.1 EXPRESSVIEW REPORT 
ExpressView allows users to explore data within a category and get quick answers using drag and drop in a highly 

interactive designer. To create an ExpressView, complete the following steps. 

1. Click the + sign on the top right that provides a list of available reports and then click ExpressView. 

 
2. A new tab will appear on the main screen of the Report Designer frame. Start selecting data fields from a 

category for analyzation.  

 
3. Use the left column of the design window to search for fields across categories. The icons: 

A. A – Show only text fields. 

B. # – Shows only numeric fields. 

C.  – Shows only date/time fields. 

D.  – Shows other fields. 

 
 

4. Once some fields are chosen, more options appear: 
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A. Options – This provides a way to save the ExpressView for use later or convert your ExpressView 

into a Standard Report to continue to work on later.  

B. Save – Saves the ExpressView. 

C. Group Expand/Collapse Options – This menu will become available when the report contains one 

or more groups. 

D. Refresh Data – Only available when the ExpressView is in Live Mode.  

E. Live Mode – Allows you to view the actual data within the data fields. 

F. Data Field Options – Blue Circle that can be accessed to group, filter, sort, and/or delete.  

 
 

G. Report Tools – Provides summarized data options of fields selected. Options include Count, Min, 

Max, and Distinct Count. 

 
 

H. Search – Search the report for data 

I. Sort – This is the same sort you would utilize in item F.  



  ExpressView 

29  ProgressBook StudentInformation Introduction to Ad-Hoc Reporting 
 

 
 

J. Filter – You can put data fields into data field values that meet all or any criteria.  

 

Note: If you wanted to filter on a different data field than what you’ve selected to review, users can 

drag from the data field column on the far left and drag over to the expanded filtering option. This 

option does not work for sorting. If you want to sort on specific fields, you must add them to the 

main column set. 

5. Once you are satisfied with the ExpressView setup, flip the switch to Turn Live Mode On and start reviewing 

data! 
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9 EXPRESS REPORT WIZARD 

Express reports are for users to create quick on the fly reports that utilize only one category and need little formatting. If 

more than one category is needed to create a report, you must use a Standard or Crosstab report feature. This is due to 

the joining that must occur between categories to ensure that the data from both categories matches up.  

9.1 CREATING AN EXPRESS REPORT 
1.  Start the Express Report Wizard by clicking Express Report from the Report Wizard Icon menu. 

 
2. On the Name Tab: 

a. Enter the name of the report. 

b. Select the folder where the report will reside. 

 

              Note: Most reports that users will create will go into the My Reports folder. 



  Express Report Wizard 

31  ProgressBook StudentInformation Introduction to Ad-Hoc Reporting 
 

3. Once all fields are completed on the Name tab, click Next to move to the Categories tab. 

4. Select one of the views that need to be included into the report and click +Add to add the category to the 

Category Name section to the right. Click Next to move to the Sorts tab. 

 
5. On the Sorts tab, select fields and then click +Add to move those fields to the right to add sorting functionality 

to the report. Once all sorting fields have been chosen, click Next to move to the Filters tab. 

 

Note: Users can use the up and down arrows to customize sorting further if necessary. If the user 

decides they do not want to use a sorting option they moved to the right, click the red x to delete 

the sorting field. 
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6. On the Filters tab, users have the option of adding fields to filter on when the report executes. If a user would like to 

add fields, they can select the field and then click +Add to move it to the right and then select conditions on how the 

values should be searched upon. See section 4.3 for Standard filtering explanation. 

 

Note: If other users use this report and values must be chosen, don’t forget to select the Prompt For 

Value check box. 

7. Once the filter fields have been selected, click Next to move to the Layout tab.  

8. On the Layout tab, the user will select the data fields that they want to view in the report. Select each field that 

needs to be viewed and click +Add to move it to the right side, or you may drag and drop the fields.  

 
On the bottom portion of the screen, the user can use basic formatting features to create a clean display of the 

data. 
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Note: Users can use the blue up and down arrows to customize sorting further if necessary. If the 

user decides they do not want to use a sorting option they moved to the right, click the red x to 

delete the sorting field. 

9. Once all fields have been selected and the layout is formatted, click Next to move to the Options tab. 

10. Further options can be configured regarding report execution.  

a. General subtab 

 
A. Include Setup Info – Provides a summary of filtering choices and places that information at the 

beginning or end of the report.  

B. Filter Execution Window – Default, Standard, Simple with Operator, and Simple without 

Operator are available. See section 4 for further details regarding filtering. 

C. No Data qualify Display Mode – This allows either a pop up message if no data is returned or will 

provide a blank report.  

 

b. Export subtab 

 
A. Default Export Type – Default option displays report to user on the screen. If the user prefers 

to automatically export into a specific format, specify that format here so the report will run 

and export. 

B. Allow Execution in Viewer – Displays report on screen if set to True. 

C. Allow Export Types – All options are set by default but if there is an option that is not allowed, 

de-select any boxes necessary.  
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D. Show grid, Simulate PDF options – Check boxes that enable an on-screen grid and/or simulate 

a PDF version of the report. 

E. Suppress Formatting – If exported into an Excel spreadsheet, any formatting on screen will 

not be included during the export process. 

F. Page Options section – Select page size, orientation, and fit to page width if desired.  

c. Advanced subtab – Converts an Express Report to a Standard Report for advanced report design.  
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10 WORKSHOP DEMOS 

1. A user needs to be able to run Attendance and Year End Reports from the Analytics Hub. Knowing that the users 

doesn’t need to schedule or edit reports, what security access would you provide or request for this user? 

2. Your principal needs a Discipline Detail list for all Active students in any grade for any infraction or action. He 

would like you to export the report into an Excel spreadsheet and email it to him later when you have time.  

3. Your treasurer wants a report of Outstanding Fees sent each week from the first day of school to the last day of 

school. How would you complete the scheduling of this report for the current school year for all buildings? 

4. You have been assigned to create a report using data fields of First Name, Last Name, and Birthdate of the 

student; the primary contact’s first name and last name; as well as the district admission date. Which categories 

are needed to create a Standard Report for the Advance training class? What do you need to know to ensure the 

future report only shows the Primary Contact?   

5. The guidance counselors like the Unapproved Course Request Detail report but they need the homeroom 

column added to the report. What do you need to do in order to achieve the report your guidance staff needs? 

6. The guidance staff at a school district near you loves what you did to the Unapproved Course Request Detail and 

would like a copy. They want to know how they can get a copy of that report for their district to use. What do 

you do? 

7. You need a quick report of student number, last name, first name, and birthdate. You want the birthdates 

highlighted in blue and the first name italicized. You want to be able to filter the report by school year, school 

name, grade level, and select several homerooms at a time. How would you complete this task? 
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11 SYNCER & SYSTEM REPORTS 

***CAN BE ONLY RUN BY ITC SYSTEM ADMINS*** 

PBST personnel will create and maintain security roles and system reports within the Pristine database. The ITCs will use 

Syncer to download the roles and reports into their production and testing databases. For Syncer to run successfully, the 

database versions between Pristine and the ITC database must match. 

1. Run Syncer.exe from command prompt. 

 
2. Enter 64 and press [Enter]. 

3. Allow Syncer to run and commit changes to the ITC database. 

 

To confirm Syncer ran successfully, log into StudentInformation and go to Local > Ad Hoc Reports.  Reports should now 

show up as read-only. 

 
 


